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Altium Designer brings a complete electronic product 
development environment to your PC’s Desktop, providing 
multi-document editing and full customization of the design 
workspace. This guide provides an introduction to Altium 
Designer and an overview of its unique, singular design 
environment. 

 

 

Altium Designer provides a unified electronic product development environment, catering for all 
aspects of the electronic development process, including: 

• System Design and Capture 

• Physical PCB Design 

• FPGA Hardware Design 

• Embedded Software Development 

• Mixed-Signal Circuit Simulation 

• Signal Integrity Analysis 

• PCB Manufacturing 

• FPGA system implementation and debugging (when working with a suitable FPGA development 
board, such as an Altium NanoBoard. 

All of these design areas are intrinsic parts of a single, cohesive system, built on Altium Designer's 
Design Explorer (DXP) integration platform. The extent of this unified system, in terms of the features 
and functionality available, will depend on the specific licensing purchased. 

Underlying Altium Designer is the DXP integration platform which brings together Altium Designer's 
various editors and software engines, and provides a consistent user-interface across all the tools and 
editors. 

The Altium Designer environment is fully customizable, allowing you to set up the workspace to suit the 
way you work. A consistent selection and editing paradigm across different editors allows you to easily 
and smoothly switch between various design tasks within the Altium Designer environment. 
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The Altium Designer Environment The Altium Designer Environment 
Altium Designer offers a unique design environment, with all areas of design – from capture to 
generation of PCB manufacturing output; from embedded software development to processing and 
download of an FPGA design into a physical FPGA device – brought together in the one environment 
through the underlying support of the DXP integration platform. Supporting the display and editing of 
multiple design documents, of differing type, this environment is fully customizable, allowing you to 
tailor the workspace resources - including menus, toolbars and shortcuts - in accordance with preferred 
design habits. 

Figure 1 summarizes some of the key elements of the Altium Designer environment. 

System Menu 
Access to features 
including 
environment 
preferences, 
licensing and 
server information 

Panel Access 
Workspace panels 
are accessible using 
these buttons 

Main Design Window
Display, arrange and 
edit open documents in 
this window 

Document Tabs 
Each open 
document has its 
own tab. Click on a 
document tab to 
make it the active 
document. Right-
click on a tab for 
further 
management 
controls 

Workspace Panels 
Various panels providing functionality specific to a 
particular editor or at a design/system level. 
Panels can be docked, placed in a pop-out mode 
or left floating 

Menus/Toolbars/Shortcuts 
Resources change according 
to the active document editor 

Navigation 
Provides controls for 
jumping to a 
particular document, 
stepping back and 
forth through viewed 
documents and 
accessing the 
integrated navigation 
Home Page 

 

Figure 1. Altium Designer 

The following sections take a closer look at these and some of the other key features and functionality 
that make up this environment. 
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Working with Documents 
In Altium Designer, each type of document is opened and edited in an associated editor. For example, 
a schematic document is opened and edited in the Schematic Editor, a PCB library document in the 
PCB Library Editor, and so on. As you create a new document or open an existing document, the 
associated editor for that document type will automatically become the active editor. 

Creating new Documents 
New documents can be created using one of the following methods: 
• select the required document type from the File » New sub-menu 

 

• click on the required entry in the New section of the Files panel. If this panel is not open, click on 
the System button at the bottom right of the main application window and choose Files from the 
pop-up menu that appears 

If one or more projects are currently open in the Projects panel, the new document will be added to the 
active project. Alternatively, to add a new document directly to an open project, irrespective of whether 
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it is the active project or not, right-click on the project’s entry in the Projects panel and choose the 
document type from the Add New to Project sub-menu. The menu will list the source documents 
typically added for that project type. 

 

Opening and Displaying Documents 
When you open a document, it becomes the active document in the application’s main design window. 
Multiple documents may be opened simultaneously. Each open document has its own tab at the top of 
the design window, but only one document may be active within that window. Figure 2 shows three 
documents open – one PCB and two schematic – with the PCB document currently active. 
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Figure 2. Multiple tabbed documents open in the main design window 

The active document is distinguished by a highlighted appearance to its tab. To make another open 
document the active document, simply click on its tab. Alternatively, use the Ctrl+Tab and 
Ctrl+Shift+Tab keyboard shortcuts to cycle forward or backward through all open documents 
respectively. 

Hiding Documents 
Various features require that all source documents be compiled and, where necessary, this compilation 
is performed automatically. For this to happen, all such documents must be opened. Depending on the 
project, there may be a sizable number of source documents involved in the compilation. To have all 
documents open as tabbed documents in the main design window can create a frustratingly cluttered 
workspace. To this end, Altium Designer provides the ability to ‘hide’ documents. They still meet the 
requirement of being open, with respect to features such as compilation, cross probing and annotation, 
but are hidden with respect to display in the main design window. 

Any open document can be placed in this hidden mode by: 
• right-clicking on its tab and choosing the Hide command 

• right-clicking on its entry in the Projects panel and choosing the Hide command. 

Hidden documents become listed in a drop-down at the far right of the Document bar which contains 
the document tabs (Figure 3). 
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Figure 3. Accessing hidden documents 

Clicking on an entry in the list will unhide the document and it will reappear as a tabbed document in 
the main design window. The main Window menu and the document’s right-click menu in the Projects 
panel also provide commands to unhide the document. 

Indicating Document Status 
As part of the General options for the Projects panel, you can enable the iconic display of document 
open/modified status. This provides a quick visual summary, allowing you to see which documents are 
open, hidden or modified (Figure 4). 

 

Use of icons to 
distinguish 
document states 
enables you to 
quickly assess 
which documents 
are modified 

Figure 4. Iconic display of document status 

The icons used are listed for ease of reference below. The entry in brackets shows the textual 
confirmation that appears when hovering the cursor over the icon. 

 (Open) - the document is open as a tabbed document in the main design window 

 (Hidden) - the document is hidden 

 (Open/Modified) - the document is open and has been modified (yet to be saved) 
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 (Modified) - this icon appears next to the main project document only, to show that the 

A modified document, p ved is also distinguished by an 

nt 
ing and working with a single design document at a 

project has been modified (yet to be saved) 

roject or design workspace that has yet to be sa
asterisk next to its entry in the panel. A modified document is also indicated by an asterisk inside its 
associated tab in the main design window. 

Document Window Manageme
With Altium Designer, you are not limited to view
time. Various commands are provided that allow you to effectively manage the open documents and 
tailor their display to your preferred working habits. 

Right-click on a document tab to access various commands for managing the document. These 
commands including closing, saving and hiding the document, as well as commands affecting the 
display of all open documents within the main design window (Figure 5). 

 

Figure 5. Accessing document management commands 

rizontally or vertically can prove invaluable when Commands for splitting the main design window ho
wishing to use cross probing with, for example, the schematic and PCB documents open side by side. 

GU0112 (v2.0) June 19, 2006  7 



Welcome to the Altium Designer Environment 

 

Figure 6. Splitting the main design window 

When split, the regions are treated as though they were individual windows. One document may be 
active in each region, but only one document, across all regions, can have the focus at any given time. 
When a new document is added, or an existing document opened, it will be opened as part of the 
region in which the currently focused document resides. 

Commands also allow you to tile the documents or merge them back into the single, default design 
window. 

Should you wish, you can open a document in its own, separate design window. Simply right-click on 
its tab and choose the Open In New Window command. Alternatively, click on the document’s tab and 
drag it onto the desktop area, outside of the main application window. Commands are then available 
from the main Windows menu to arrange the separate windows horizontally (Figure 7) or vertically. 
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Figure 7. Horizontally arranging Altium Designer windows on the Desktop 

Enlarging the Design Canvas – Dual Monitor Support 
Altium Designer supports the use of dual 
monitors, with a recommended resolution of 
1280x1024. With many documents open 
concurrently and a plethora of workspace 
panels, toolbars and support documents, this 
feature affords you space enough to define a 
more comfortable working environment. You 
might, for example, dedicate the use of one 
monitor solely for design, while arranging 
various workspace panels and additional 
documents on the other. 
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Organizing the Environment - Desktop Layouts 
As a further aid in setting up the workspace environment, Altium Designer supports the notion of 
Desktop Layouts. This feature allows you to arrange the application’s document windows, workspace 
panels and toolbars around the desktop as required and then save that layout to file. In this way, 
multiple users can quickly arrange the workspace to suit their design habits by loading in their preferred 
layout. 

Commands for saving and loading layouts, including the default layout shipped with the software, are 
available from the View » Desktop Layouts sub-menu. 

Document Storage 
Altium Designer stores all design documents and generated output files on your hard disk as individual 
files. You can use the Windows Explorer to search for them. Design documents will typically be 
encapsulated into projects, both for management and to access certain design features, such as 
design verification, comparison and synchronization. A project file contains links to design documents, 
as well as any other project-level definitions. 

Projects 
Altium Designer allows you to create and maintain the following project kinds: 
• PCB project (*.PrjPcb) 

• FPGA project (*.PrjFpg) 

• Core project (*.PrjCor) 

• Embedded project (*.PrjEmb) 

• Library package (*.LibPkg) 

• Script project (*.PrjScr) 

A new project of any of the above types can be created using one of the following three methods: 
• select the required project type from the File » New » Project sub-menu 
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• click on the required entry in the New section of the Files panel. If this panel is not open, click on 
the System button at the bottom right of the main application window and choose Files from the 
pop-up menu that appears 

 

• click on the associated design area link in the Pick A Task section of the Home Page (View » 
Home) and then click on the available entry to create a new blank project 
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As you open an existing project, or create a new one, an entry for it will appear in the Projects panel. 
Any existing documents that are part of a project and any new ones that may be added, will appear 
under sub-folders, according to their purpose and/or type. 
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Figure 8. The Projects panel 

For further information about projects, see the Project Essentials application note. This application 
note includes information on the role of projects in the design process, the different kinds of projects 
available, techniques for working on projects and how to use the Projects panel effectively. 

For further information on the Projects panel, press F1 when the cursor is over the panel. 

Project File Management – The Storage Manager 
To allow greater control over the management of files in projects, Altium Designer features a dedicated 
Storage Manager. Implemented as a workspace panel (see Workspace Panels) the Storage Manager 
can be accessed by clicking on the System button at the bottom of the application window and 
choosing Storage Manager from the subsequent pop-up menu that appears. Once opened, the 
Storage Manager presents a folder/file view of the active project’s documents (Figure 9). 
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Figure 9. The Storage Manager panel 

The Storage Manager panel can be used for: 

• general everyday file management functions – for files in the project or within the active project’s 
folder structure 

• management of symbol and footprint libraries stored in an SVN repository and associated with an 
SVN Database Library. The panel provides access to the local working directory into which a copy 
of the libraries stored in the repository are checked out. Committal of changes to the repository and 
reception of updates from the repository can only be performed through the panel. 

• management of backups using the Local History feature (see Document Management – Local 
History) 

• as an SCC (Source Code Control) compliant version control interface for your projects 

• as a CVS compliant (Concurrent Versions System) interface for your projects 

• as an SVN (Subversion) compliant interface for your projects 

• performing a physical and electrical comparison of any two versions in either the Local History  or 
the VCS Revision list. 
For further information on the Storage Manager panel, press F1 when the cursor is over the panel. 
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Design Workspaces 
As you can open and edit multiple design projects in Altium Designer, provision is made for you to be 
able to save a set of open projects as a Design Workspace (*.DsnWrk). This can prove to be a highly 
efficient option when working with multiple projects that are closely linked in some way. For example, 
you may have a PCB design that incorporates one or more FPGA devices. The designs targeting those 
devices may include processor cores, within which, dedicated embedded software programs will run. 
Instead of having to remember and open the individual projects involved (PCB, FPGA and Embedded), 
all three projects can be saved, opened and manipulated as a single design workspace. 

Document Management – Local History 
Working in harmony with the Storage Manager panel, an internal version history management system 
allows you to track document changes without the use of an external version control system. Document 
history management includes the ability to view differences – both physical and logical – as well as 
revert to previously saved versions of the document. 

Local document history management also works in harmony with an installed Version Control System. 
Individual designers can manage their own changes using the local history system, with the VCS 
providing a complete team-oriented document management system. 

The approach of the local history management system is to take a copy of a file each time you perform 
a Save, keeping all the copies in a project History folder (the copy is the file before the save event). 
The project History folder is created in the same folder as the project file. If your project includes 
documents stored in sub-folders, then this sub-folder structure will be repeated within the History 
folder. 
You can also use a central repository for the history of all projects. Configure this on the Version 
Control – Local History page (Figure 10) of the Preferences dialog (accessed by choosing 
Preferences from the main DXP menu). The number of days of file history is also configured here too. 
A history of file save events will continue to be maintained for this many days. 

 

Figure 10. Options for the Local History feature 
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The lower region of the Storage Manager panel shows the local history for the selected file, with each 
history file being labeled Version x, where x increments with each save. Right-click on a saved 
version to Apply a Label; this allows you to ‘tag’ a particular version for later reference. 

Right-click on a file in the history list to Open it, or to Revert to that version. Ctrl+click to select two 
files, then right-click to Compare them (Figure 11). 

 

Figure 11. Comparing two versions of a document 

Document Management – External Version Control 
Version control is becoming the preferred method of electronic document management within many 
companies. Not only do version control systems provide safe and controlled storage and retrieval of a 
company’s valuable documents, they also support easy retrieval of an older version of a document, 
and with suitable comparison tools, the ability to detect and examine document changes. 

Use the options available on the Version Control – General page of the Preferences dialog to select 
either an SCCI compliant VCS, or to interface directly to either the CVS or SVN version control system. 

If your project files are already stored in your version control system and checked out into a suitable 
working folder (or sandbox), you must also establish an initial connection between Altium Designer and 
the VCS-controlled project. To establish this connection, right click on the project file in the Storage 
Manager panel and select Add Project To Version Control. This will not create another copy of the 
project in the VCS, it will simply allow the appropriate VCS files and settings to be configured correctly, 
so that whenever you work on this project in the future, Altium Designer will recognize that it is under 
source control and correctly reflect the status of the documents. If the project was not already under 
version control, then use this process to add the project files (in the current folder) to the storage 
repository. 
Once this step has been performed, you can then modify and Check In (or Commit) changes back to 
the repository directly from the Storage Manager panel. If you are working with CVS or SVN directly, 
the VCS Revisions section of the Storage Manager panel will list the revision information for the 
active file (Figure 12). 
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Figure 12. Accessing revision information in the Storage Manager panel 

For further information on managing your design documents using an external VCS, refer to the 
Working with a Version Control System tutorial. 

Document Editor Resources 
Each document editor has an associated set of default resources – menus, toolbars and shortcuts – 
the definitions of which are stored in corresponding resource files (*.rcs). These files can be found in 
the \System folder of the installation. 

As you change back and forth through different document types in the main design window, the 
resources associated with that document’s editor will automatically be loaded. 

Behind each menu command, toolbar button and shortcut definition lies a pre-packed process 
launcher, which contains the process to run, along with any specific parameters, when the menu 
entry/toolbar button/shortcut key is invoked. 

Any of the resources for an editor can be modified or added to as required, enabling you to fully 
customize your working environment to your own needs and preferences. Access to the relevant 
customization dialog for an editor can be made in one of the following ways: 
• right-click on a menu bar or toolbar and choose Customize from the pop-up menu that appears 

• double-click on a blank area of a menu bar or toolbar 
• choose Customize from the main DXP menu. 

For further information on customization of the design environment, refer to the Customizing the 
Altium Designer Resources tutorial. This tutorial includes rearranging the existing menus and 
toolbars, adding and deleting toolbar or menu commands, creating new drop-down menus and 
working with shortcut key tables. 

Workspace Panels 
Workspace panels are a staple ingredient of the Altium Designer environment. Whether specific to a 
particular document editor or used on a more global, system-wide level, they present information and 
controls that aid productivity and allow you to design in a more efficient capacity. 

Accessing Panels 
When the Software is first started, a number of panels will already be open. Some panels, including the 
Files and Projects panels, will appear grouped and docked to the left side of the application window. 
Others, including the Libraries panel will be in pop-out mode and appear as buttons on the right-hand 
border of the application window. 
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At the bottom of the application window there are a number of buttons that provide quick access to the 
available workspace panels, in context with the document editor you are currently using. Each button is 
labeled with the name of the category of panels it gives access to. When a button is clicked, a pop-up 
menu of the constituent panels in that category will appear. 

 

Figure 13. Accessing workspace panels 

Click on an entry in a menu to open the corresponding panel. A tick symbol is used to indicate that the 
associated panel is open and visible in the workspace. If a panel is open but not visible, for example it 
is a non-active panel in a group of docked panels or it is currently in pop-out mode, clicking its entry in 
a menu will make it visible and it will become the active panel. 
All currently available workspace panels can also be accessed from the View » Workspace Panels 
sub-menus. 

Managing Panels 
Depending on the particular document editor that is currently active, a large number of panels may be 
accessible or indeed open at any given time. To facilitate the layout and use of multiple panels in the 
workspace, various panel display modes and management features are provided. 

Panel Display Modes 
Three different display modes are supported for panels: 
• Docked Mode - In this mode a panel can be docked horizontally or vertically within the main 

application window. Right-click on a panel's title bar or tab and choose Allow Dock from the pop-up 
menu to configure the docking capability of the panel - horizontally and/or vertically 

When docking vertically, a panel will dock to the right or left of the main design window. When 
docking horizontally, a panel will dock either above the main design window (and below docked 
toolbars) or below the main design window (and above the Status Bar) 
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Vertically docked panels 

Horizontally docked panel

 

• Pop-out Mode - This mode is essentially an extension of the standard docked mode. A docked 
panel can be put into this mode by clicking on the pin symbol next to the panel's close cross. The 
pin symbol will change to indicate the mode: 

 panel in original docked mode 

 panel now in pop-out mode. 

In this mode, the panel will appear as a button on the application border. Moving the cursor over the 
panel button will result in the panel sliding out from the border. Moving the cursor away from the 
panel will cause it to slide back again. Clicking on the panel button will expand the panel without 
sliding. In this case, click away from the panel to slide it back again 
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Panels placed in pop-out 
mode appear as buttons 
along the application 
border 

Panels that have 
been ‘popped 
out’ 

• Floating Mode - In this mode a panel can be placed anywhere within, or outside of, the Altium 
Designer environment. This is the standard opening mode for panels that have not been previously 
placed in docked or pop-out modes 

• Floating Mode - In this mode a panel can be placed anywhere within, or outside of, the Altium 
Designer environment. This is the standard opening mode for panels that have not been previously 
placed in docked or pop-out modes 

A floating panel positioned over the editing area of the main design window will be made 
transparent when carrying out an interactive operation in the main design window, in accordance 
with options defined on the System - Transparency page of the Preferences dialog (DXP » 
Preferences). 

A floating panel positioned over the editing area of the main design window will be made 
transparent when carrying out an interactive operation in the main design window, in accordance 
with options defined on the System - Transparency page of the Preferences dialog (DXP » 
Preferences). 
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Floating panels can be made 
transparent when performing an 
editing action in the main design 
window, so as not to impede 
your activity 

 

Grouping Panels 
Panels may be grouped by simply dragging and dropping one panel on top of another. The resulting 
display of the group depends on where exactly you 'drop' the panel being added. Two modes of 
grouping panels are supported: 
• Standard tabbed grouping - This mode displays a set of panels as a tabbed group, with only one 

panel in the group visible at any time. 
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Use one of the following methods to group panels in this fashion: 

Drag the panel you wish to add to the center of the target panel (or existing group) and drop. A 
yellow positional arrow will appear to the right of the tab(s) for the target, indicating that the panel 
will be added to the group as another tab. Shading (blue) and icons are used to also indicate where 
in relation to the target, the panel you are moving will be added. Dragging the panel to the center 
will cause the entire target panel/group to become shaded. 

 

Drag the panel you wish to add to the region containing the tab(s) for the target panel (or existing 
group). The entire target panel/group will be shaded and a yellow positional arrow will appear, 
indicating that the panel will be added to the group as another tab. Simply move the mouse until the 
arrow indicates the specific position within the group where you wish to place the new panel and 
drop. 

Use the small down-arrow at the top-right of the panel grouping to change the visible/active panel. 
Alternatively, make another panel in the group the visible/active panel by clicking directly on its tab. 
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The order of the panels in a tabbed group of panels can be changed at any time. Simply click on a 
panel's tab and drag to the left or right as required. A positional arrow will appear marking the 
position in the group order at which the panel will be placed if the mouse button is released 

• Fractal grouping - This mode displays a set of panels as a fractal grouping, with multiple panels in 
the group visible at the same time. 

 

This mode is analogous to horizontal/vertical tiling of open windows - you can simply drag a panel 
to dock it within another panel, effectively tiling them. 

A fractal grouping can consist of individual panels and/or standard tabbed panels. 

To group panels in this fashion, simply drag the panel you wish to add towards the top, left, right or 
bottom of the target panel (or existing group) and drop. The direction you choose determines 
where, in relation to the target, the new panel will appear. As you move the panel over the target, 
shading and icons will be evident – use these to help locate the panel at the required position. 
Ensure that no yellow positional arrow is displayed when adding the panel, otherwise it will be 
added to the target as an additional (and standard) tabbed panel. 

GU0112 (v2.0) June 19, 2006  23 



Welcome to the Altium Designer Environment 

 

To make a panel active in a fractal grouping, simply click on it. If the required panel is part of a 
tabbed grouping within the overall fractal structure, simply make it visible/active by clicking on its 
corresponding tab. 

Moving Panels 
A single floating or docked panel is moved by clicking within the panel's header and dragging it to a 
new position. 

For a single panel that has been put in pop-out mode, the panel can be also moved by clicking on its 
corresponding button in the application border and dragging the panel to the intended position. 

When panels have been grouped (either tabbed or fractal), clicking within a panel's header and 
dragging will move all panels in that group. To move a single panel elsewhere, thereby disassociating it 
from its group, click and drag the panel by its caption (or its tab if available). 

To take a panel out of fractal grouping mode (where it has been tiled) and back into a standard tabbed 
grouping, simply drag the tiled panel, by its caption, to a target panel or existing tabbed group until a 
yellow positional arrow appears (target becomes fully shaded) and then release - the panel will be 
added to the tabbed grouping. 

Moving a panel to an application border that already contains one or more panels, will result in the 
panel being added in the same mode (docked or pop-out) as those already present. 

As you move a panel close to another floating panel, the edges will snap together. Similarly, moving a 
panel towards the extremities of the desktop will snap the panel to the desktop's edge. This 'snap-
attraction' feature allows for easier arrangement of floating panel sets within the environment. 
When moving a panel, to prevent it from automatically docking, grouping or snapping, use the Ctrl key. 
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Closing Panels 
A panel can be closed by right-clicking in its title bar (or on its tab, where available) and choosing the 
Close entry from the subsequent pop-up menu. 

Use the 'close cross' at the far right of a panel's header to close an individual panel. However, if the 
panel is part of a group (fractal or standard tabbed), using this cross will close all panels in the group. 

Maximizing/Restoring Panels 
When in floating mode, a panel can be maximized by right-clicking in its title bar (or on its tab, where 
available) and choosing the Maximize entry from the subsequent pop-up menu. To restore a 
maximized panel back to its original size, simply right-click in its title bar or tab and choose the Restore 
command from the pop-up menu. 

Alternatively, double-click in the title bar to toggle between maximized and restored state. 

For further information on workspace panels, refer to the Altium Designer Panels Reference. This 
reference provides complete and detailed information with respect to all panels available. 

Environment Settings 
Altium Designer streamlines the setting of environment options across all document editors and 
servers, by centralizing these options within a single, context-sensitive dialog – the Preferences dialog 
(Figure 14). Featuring a tree-like navigation structure, the dialog not only allows you to quickly and 
efficiently set system-wide preferences, but also load and save favorite preference settings, giving you 
still greater control over your working environment. 
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Figure 14. The Preferences dialog – command central for Altium Designer environment settings 

Access to this dialog is made by choosing the Preferences command from the DXP main menu. From 
within an editor, you can also access the dialog using the relevant Preferences command (e.g. Tools 
» Schematic Preferences from the schematic main menus). 

Navigation 
To aid navigation of design documents, Altium Designer provides a dedicated Navigation toolbar 
(Figure 15), which can be accessed from within any of the application’s document editors. 
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Figure 15. Dedicated document navigation tools 

Direct Document Navigation 
The field at the left of the bar enables you to navigate to any directory or document on any network or 
local storage medium, as well as any page on the internet. Simply type or paste the destination 
address into the field and press the Enter key. The destination directory or document will open as the 
active view in the main design window. 

Destination addresses for directories and folders on local or network storage mediums take the form:  
file:///RootDirectory:/Path/Document 

Destination addresses for documents on the internet take the standard URL form:  
HTTP://WebAddress 

All Altium Designer integrated navigation support pages take the form:  
DXP://DocumentName  

The field in which you enter the destination address is actually a drop-down list which provides a 
history of all destination addresses (valid and invalid) which have been previously entered. This history 
list is not persistent across design sessions. It is cleared upon exiting the software. 

Browsing Viewed Documents 
The left and right arrow buttons allow you to effectively pass back and forth through documents that 
have previously been opened as active views in the main design window. The drop-down arrows 
located to the immediate right of these buttons provide a list of all documents that are part of the 
backward or forward browse sequence respectively. Click on an entry to view that document directly. 

Integrated Navigation Pages 
Click the  button to access the Home page – part of the Altium Designer integrated navigation 
support pages. 
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Figure 16. Integrated navigation Home Page 

This is the top-level page from where all predefined navigation support pages can be accessed. Each 
support page provides links to perform common tasks (e.g. creating a project or document file), as well 
as links to relevant documents contained within the Altium Designer Documentation Library (Figure 
17). 
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Figure 17. Support pages are available across the key areas of design 

Localization for Foreign Languages 
Altium Designer provides support for Chinese (Simplified), Japanese, German and French language 
installations. All menu items and most dialog text can optionally reflect the language chosen from those 
installed on the PC. The localized language is available as either translated hints over English text, or 
in translations of the forms and menus themselves. 
Localization is configured on the System – General page of the Preferences dialog (DXP » 
Preferences). 

 

Figure 18. Setting localization options 
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Importing Design Files Importing Design Files 
Altium Designer incorporates a wide variety of importer and translator technologies, allowing you to 
effortlessly import designs originating from previous versions of the software or alternative software 
packages. Import of such files can be performed using the Choose Document to Open dialog (Figure 
19), accessed by choosing the Open command from the main File menu. 

Altium Designer incorporates a wide variety of importer and translator technologies, allowing you to 
effortlessly import designs originating from previous versions of the software or alternative software 
packages. Import of such files can be performed using the Choose Document to Open dialog (Figure 
19), accessed by choosing the Open command from the main File menu. 

Use the Files of type filter to 
quickly find the file you wish to 
import 

  
Figure 19. Importing documents using the Open command Figure 19. Importing documents using the Open command 

The following non-Altium Designer documents can be imported: The following non-Altium Designer documents can be imported: 
• Protel 99SE Design Database (*.DDB) • Protel 99SE Design Database (

• P-CAD V16 or V17 ASCII Schematic (*.sch) • P-CAD V16 or V17 ASCII Schematic (

*.DDB) 

• P-CAD V16 or V17 ASCII Schematic Library (*.lia) • P-CAD V16 or V17 ASCII Schematic Library (

*.sch) 

• P-CAD V15, V16 or V17 ASCII PCB (*.pcb) • P-CAD V15, V16 or V17 ASCII PCB (

*.lia) 

*.pcb) 

• P-CAD PDIF file (*.pdf) • P-CAD PDIF file (

• CircuitMaker 2000 Design (*.ckt) • CircuitMaker 2000 Design (

*.pdf) 

• CircuitMaker 2000 Binary USER Library (*.lib) • CircuitMaker 2000 Binary USER Library (

*.ckt) 

*.lib) 

• OrCAD Layout file (*.max) • OrCAD Layout file (

• OrCAD Max Library file (*.llb) • OrCAD Max Library file (

*.max) 

• OrCAD Capture Design (*.dsn) • OrCAD Capture Design (

*.llb) 

• OrCAD Capture Library (*.olb) • OrCAD Capture Library (

*.dsn) 

• OrCAD CIS Configuration file (*.dbc) • OrCAD CIS Configuration file (

*.olb) 

*.dbc) 

• PADS PCB file (*.asc) • PADS PCB file (

• SPECCTRA Design file (*.dsn) • SPECCTRA Design file (

*.asc) 

*.dsn) 
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Importer Wizard 
To make the import process as smooth and efficient as possible, Altium Designer provides a unified 
means of importing designs from a variety of different design tools – the Importer Wizard. The Wizard 
walks you through the import process, handling both the Schematic and PCB parts of the project, as 
well as managing the relationship between them. 

The Wizard can be used to import the following types of design projects: 

• Protel 99 SE design databases 

• CircuitMaker 2000 schematics and libraries 

• P-CAD designs and libraries 

• OrCAD designs and libraries 

• OrCAD CIS Configuration files and libraries 

• PADS ASCII PCB designs and libraries 

• OrCAD and PADS designs and libraries. 

 

Figure 20. Importing from a variety of design tools using the Import Wizard. 

For further information on importing a Protel 99SE design, refer to the Moving to Altium Designer 
from Protel 99 SE article. 

For further information on importing a design from P-CAD, refer to the Moving to Altium Designer 
from P-CAD application note. 

For further information on importing a design from OrCAD, refer to the Moving to Altium Designer 
from OrCAD application note. 
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Exporting Design Files Exporting Design Files 
Design files (e.g. schematic, PCB) or projects themselves may be exported into various formats – 
including previous versions of the software or alternate software packages. Export of such files is 
performed using the Save As dialog (Figure 21), accessed by choosing the relevant Save command 
from the main File menu. 

Design files (e.g. schematic, PCB) or projects themselves may be exported into various formats – 
including previous versions of the software or alternate software packages. Export of such files is 
performed using the Save As dialog (Figure 21), accessed by choosing the relevant Save command 
from the main File menu. 

Use the Save as type filter to 
determine into which format 
you wish to export the file 

  
Figure 21. Exporting design files using the Save As command Figure 21. Exporting design files using the Save As command 
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Documentation and Help 
The Altium Designer documentation is 
accessed through the Knowledge Center 
panel.  
The Knowledge Center panel presents 
help information while you work. It tracks 
the command, dialog, object, or panel that 
is currently under the cursor and loads 
help about it – hover for a second or so 
for the content to appear. If you would 
prefer to 'freeze' the content of the panel 
at the currently loaded topic, simply click 
the Autoupdate button  to disable 
auto-loading. You can still use F1 to load 
content with autoupdate disabled.  
The Knowledge Center panel is a portal, 
from the concise help summary displayed 
in the top of the panel there are links to 
PDF based reference and applied 
documents.  

The lower section in the panel has a 
navigation tree, use this to browse 
through the PDF-based documentation, 
and open a document of interest. 
The Knowledge Center panel includes a 
powerful PDF searching feature, available 
at the bottom of the panel. Pages that 
include all words in the search string are 
returned (except common words such as 
and, or, etc). The search scope is 
determined by your current location in the navigation structure. 

 
Figure 22. Use the Knowledge Center panel to learn about what 
you are doing, or use it to browse and search the extensive PDF-
based documentation library. 

Access to Shortcuts 
Perhaps the single thing you can do to become more productive in any software environment is to 
learn the shortcut keys. Keystrokes are more efficient than carefully positioning a mouse over a button 
or drilling through menus, and once learned become second nature. In a multi-editor environment like 
Altium Designer it can be hard to remember the shortcuts, particularly those special-purpose ones that 
are available when you are running a command. To help with this Altium Designer provides a shortcut 
menu, that can be used from within all interactive Schematic and PCB commands. When a command 
is running, for example Place Wire, simply press the tilde key (~) and a menu will appear, listing all of 
the valid shortcuts for that stage of the interactive command. 
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Figure 23. Fast access to shortcuts available during an interactive process 

Use the menu to refresh your memory about the shortcuts available, or use it in the traditional menu 
sense, to select the required option with the mouse. 
By keeping the Shortcuts panel visible, you can quickly peruse the shortcuts available to you, 
depending on what you are working on. For example, simply having a schematic document open will 
show the various Schematic Editor shortcuts. 

 

Figure 24. The Shortcuts panel – enhanced productivity at your fingertips. 
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What’s This? Help 
Use the 'What's This Help' facility to gain detailed information about each of the individual options 
available in a dialog. Simply click on the question mark button at the top right of a dialog and then click 
over a field or option to pop-up information specific to that field or option. 

 
Figure 25. Using the What’s This Help feature to access dialog option information 

Web Update 
In order to keep your Altium Designer software, libraries and documentation up-to-date, a web update 
feature is provided (DXP » Check For Updates). 

 

Figure 26. Web Update – ensuring you have the latest tools 

As well as checking for available updates on the Altium Website, you can also configure the feature to 
check a network location – ideal if your company has multiple installations of Altium Designer. You can 
also enable automatic checking for updates. All configuration is carried out from the System – Altium 
Web Update page of the Preferences dialog (DXP » Preferences). 
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Figure 27. Configuring the Web Update feature 

The Design Explorer (DXP) Integration Platform 
The DXP platform provides the key to integration of the various design tools into the single Altium 
Designer environment. As part of this integration, its job is to provide consistent user interfaces and 
enhanced tool-interoperability. 

Beyond this integration, it is also responsible for providing a wide range of features that are common 
across tools, saving multiple implementations of the same features and therefore speeding up the 
development process. As a result, DXP-based applications are inherently more feature rich than other 
applications. 

Externally, the platform presents all the features that the user interacts with – menus, toolbars, panels 
and shortcut keys. Internally, it is the platform that each server plugs into. When a server is plugged in, 
it tells the DXP platform what functions (or processes) it includes and passes over a definition of all its 
menus, toolbars and shortcuts (resources). When a user selects a menu item, DXP passes a message 
to the appropriate server, telling that server what process to run. 
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What is a Server? 
In everyday computer-user language, a server is a module that plugs into the DXP platform, to add 
new functionality to the environment. It can range from a complete document editor, such as the 
Schematic Editor, to a complex analysis engine, such as the Mixed-Signal Circuit Simulator, through to 
a simple utility that counts all the holes on a printed circuit board. 

In software jargon, each Altium Designer server is a DLL (Dynamic Link Library). In Microsoft Windows 
a DLL is a library of functions and procedures, which can be used by any application and other DLLs. 
Microsoft developed the EXE/DLL model to allow software to be reusable. Software functions that are 
used by more than one application are stored in these libraries, which can then be called when the 
application needs that function. Windows is structured so that using a function from a library (DLL) is as 
quick and easy as using a function that is internal to the application. 

Altium Designer – through its DXP platform – extends this model by making the functions and 
procedures inside each server DLL directly available to the user, through menus, toolbars and 
shortcuts. 

As well as exposing the functionality of a server to the user through the menus, toolbars and shortcuts, 
each server exposes its functionality to other servers through an open Application Programming 
Interface (API). The API is the definition of how all the functions in a DLL are used. An API is called 
“open” when this definition is published, so that the functions in this DLL can be accessed by other 
EXEs and DLLs. 

As well as allowing programmatic access to the same functions that the user can access through the 
resources, the API also includes more powerful functions that support direct manipulation of 
information in the design document that the editor currently has open. An example of this is the 
Schematic server – when it has a Schematic document open for editing, the Mixed-Signal Circuit 
Simulator can examine the contents of this document, directly through the API. Using this mechanism, 
it can extract information about the objects on the Schematic, required to perform the simulation and 
ultimately generate a waveform analysis. 

Viewing Installed Servers 
The list of currently installed servers (i.e. plugged into the DXP integration platform) can be viewed 
from the EDA Servers dialog (Figure 28). Access to this dialog is made by choosing the System Info 
command from the main DXP menu. 
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Figure 28. Displaying the list of installed servers 

Servers can be grouped into three distinct categories: 
• Document Editor/Viewers – these servers present a document editing (or viewing) window. 

Examples include the Schematic and PCB Editors 
• Wizards – these servers pop up as a Wizard, where you step through a number of pages and 

answer questions. Examples include the Printed Circuit Board Wizard (PCBMaker) and the 
Component Maker Wizard (CompMake) 

• Utility Servers – these servers work with one of the Document Editor servers. Typically they add 
items to the Document Editor’s menus to allow access to their features. Examples are the Mixed-
Mode Simulation Server (SIM), and the Hole Size Editor (HSEdit). 

Use the commands available from the dialog’s menu (button and right-click) to view information about a 
selected server in the list. Alternatively, double-click on an entry directly. The Server dialog will appear, 
from where you can gain information on any document editors that the server provides and a list of 
processes that it provides (Figure 29). 
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Figure 29. Interrogating server properties 

Getting Started with Altium Designer 
The following list of documents provide further exploration of the environment and information that will 
aid you in getting started with designing using the Altium Designer software: 

Introduction to Altium Designer - this article details how and where to find the answers to your 
design questions, and how to get the most out of the vast 
pool of knowledge available for and within Altium Designer. 

An Overview of Electronic Product 
Development in Altium Designer

- this article describes an entire design from the Engineer’s 
perspective, dividing the job between PCB and FPGA 
design, then using Altium Designer’s integrated tools to 
complete both. 

Getting Started with PCB Design - this tutorial is designed to give you an overview of how to 
create a schematic, update the design information to a PCB 
and generate manufacturing output files. It also investigates 
the concept of projects and integrated libraries. 

Getting Started with FPGA Design - this tutorial gives an overview of how to create an FPGA 
design. It outlines how to create a schematic and then 
compile, synthesize, build and program a physical FPGA 
device on one of the Altium NanoBoard’s satellite 
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daughterboards. It also looks briefly at the use of sub-sheets 
and VHDL files in an FPGA design. 

Getting Started with Embedded 
Software

- this tutorial shows how to create an embedded software 
project with Altium Designer. 

Project Essentials - this application note outlines the different kinds of projects, 
techniques for working on projects and how to use the 
Projects panel effectively. 

Schematic Editing Essentials - this application note looks at the placement and editing of 
schematic objects in Altium Designer. 

Connectivity and Multi-Sheet 
Design

- this article discusses the structural and connective 
considerations involved in multi-sheet design, then 
describes the different browsing tools that let you verify net 
connectivity across source documents. 

Creating a Multi-channel Design - this tutorial shows how to create a multi-channel design in 
the Schematic Editor, including the use of sub-sheets, sheet 
symbols and the Repeat keyword. Setting room and 
designator formats and viewing the channel designator 
assignments are also covered. 

Editing Multiple Objects - this tutorial describes various techniques for applying edits 
globally to multiple objects in your design. It covers using the 
Find Similar Objects dialog and Inspector panel 
combination, as well as the Parameter Manager and the 
Model Manager. Finally it introduces queries and the use of 
the filter and list-based panels, which together provide a 
powerful technique for finding and editing design objects. 

Verifying Your Design in Altium 
Designer

- this article discusses everything that the designer has to do 
to be confident that their design is ready for PCB Layout, 
from the kinds of problems that are common, why they 
happen, and strategies to assist with building the product 
right. 

Preparing the Board for Design 
Transfer

- this tutorial shows how to define the board shape, configure 
the drawing sheet, setup the layers, and define any keepout 
requirements, in preparation for transferring the design from 
the Schematic Editor. 

Specifying the PCB Design Rules 
and Resolving Violations

- this article introduces the PCB Design Rules System, in 
particular how rules are created and applied to objects in a 
design. It also describes how defined rules are checked 
using online or batch DRC tools and discusses navigating 
and resolving violations. 
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Interactive and Differential Pair 
Routing

- this application note describes how Altium Designer’s 
interactive routing features can be used to help you 
efficiently and accurately route your board. 

Finding Differences and 
Synchronizing Designs

- this article provides an overview of the process used by 
Altium Designer to keep your schematic and PCB designs 
synchronized. The facilities for detecting and resolving 
design differences are covered in particular. 

FPGA Designer’s Quickstart Guide - this guide gives an overview of using the Altium Designer 
environment to develop an FPGA design. 

Design Portability, Configurations 
and Constraints

- this article describes what is required for design portability 
and the role of configurations and constraints in achieving 
this portability. 

Implementing a Simple Processor-
Based Design in an FPGA

- this tutorial describes how to implement a processor-based 
design in an FPGA. It describes the creation of FPGA and 
Embedded projects, creating C files, setting up processor 
and compiler options and then configuring and programming 
the design to an FPGA device. 

Component, Model and Library 
Concepts

- this article defines components, models and libraries, and 
their relationships. The search sequence for locating models 
is explained, as well as options that make this search more 
restrictive for specific models. 

Creating Library Components - this tutorial covers the creation of schematic components 
and PCB footprints using the Schematic and PCB Library 
Editors in Altium Designer. 

Using Components Directly from 
Your Company Database

- this application note provides detailed information on using 
components from a database using Altium Designer’s 
database library feature. 

Customizing the Altium Designer 
Resources

- this tutorial describes how to customize your Altium 
Designer resources, such as commands, menus, toolbars 
and shortcut keys. It covers rearranging the existing menus 
and toolbars, adding and deleting toolbar or menu 
commands, creating new drop-down menus or toolbars and 
working with shortcut key tables. 

Moving to Altium Designer from 
Protel 99 SE

- this article outlines the process you go through to transfer a 
Protel 99 SE design into the Altium Designer environment. 

Introduction to the Query Language - this article introduces the query language and points readers 
to the resources within Altium Designer for understanding it. 
These resources include example queries in the History and 
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Filter pop-up lists, and generation tools such as the Query 
Builder and Query Helper. 

Shortcut Keys - this guide provides a list of shortcut keys available for use 
within Altium Designer’s various Document Editors. 

Revision History 
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